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About This Guide

This guide documents the Console Manager for SGIconsole release 1.0 running on
SGI systems.

The Console Manager software graphical interface allows you to control multiple SGI
servers, SGI partitioned systems, and large single-system image servers.

This manual contains the following chapters:

• Chapter 1, "Console Manager Features and Capabilities", page 1

• Chapter 2, "Configuring Console Manager", page 17

• Chapter 3, "Configuring Sites", page 27

• Chapter 4, "Administering Your Site", page 37

• Appendix A, "SGIconsole Log Files and Console Manager Execution Flow", page 51

Related Publications
The following documents contain additional information that may be helpful:

• SGIconsole Software CD Information Card

• SGIconsole 1.0 Start Here

• IRISconsole to SGIconsole Migration Guide

• SGI Origin 3000 Series Owner’s Guide

Appendix B of this manual contains information about L1 and L2 controller
commands that can be invoked from SGIconsole.

• SGIconsole Hardware Connectivity Guide

• EL Serial Port Server Installation Guide

• EL Serial Port Server Installation Guide Errata

This document describes how to configure the Silicon Graphics Ethernet serial
port server for Linux environments.
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About This Guide

• Performance Co-Pilot ReadMe First

• Performance Co-Pilot IRIX Base Software Administrator’s Guide

• Performance Co-Pilot Programmer’s Guide

• Performance Co-Pilot User’s and Administrator’s Guide

Obtaining Publications
To obtain SGI documentation, go to the SGI Technical Publications Library at:

http://techpubs.sgi.com.

Conventions
The following conventions are used throughout this document:

Convention Meaning

command This fixed-space font denotes literal items such as
commands, files, routines, path names, signals,
messages, and programming language structures.

variable Italic typeface denotes variable entries and words or
concepts being defined.

user input This bold, fixed-space font denotes literal items that the
user enters in interactive sessions. Output is shown in
nonbold, fixed-space font.

[ ] Brackets enclose optional portions of a command or
directive line.

... Ellipses indicate that a preceding element can be
repeated.

Reader Comments
If you have comments about the technical accuracy, content, or organization of this
document, please tell us. Be sure to include the title and document number of the
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manual with your comments. (Online, the document number is located in the front
matter of the manual. In printed manuals, the document number is located at the
bottom of each page.)

You can contact us in any of the following ways:

• Send e-mail to the following address:

techpubs@sgi.com

• Use the Feedback option on the Technical Publications Library World Wide Web
page:

http://techpubs.sgi.com

• Contact your customer service representative and ask that an incident be filed in
the SGI incident tracking system.

• Send mail to the following address:

Technical Publications
SGI
1600 Amphitheatre Pkwy., M/S 535
Mountain View, California 94043–1351

• Send a fax to the attention of “Technical Publications” at +1 650 932 0801.

We value your comments and will respond to them promptly.
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Chapter 1

Console Manager Features and Capabilities

Console Manager is a graphical user interface for the SGIconsole management and
monitoring tool used to control multiple nodes. A node can be a server or a
partitioned system. Each node is a managed host with a unique name and Internet
Protocol (IP) address. An SGI Origin 3000 system can be partitioned to contain
multiple nodes. Each partition is a node with a unique hostname and IP address.

You can manage and monitor up to 32 nodes with the Console Manger.

You can use the Console Manager interface to consolidate information about multiple
sever nodes in a compact space.

The Console Manager is part of the SGIconsole system, which is used to control and
monitor multiple SGI servers. For an overview of SGIconsole, see "SGIconsole
Overview", page 14, and the SGIconsole 1.0 Start Here.

This chapter introduces the operational features and capabilities of Console Manager
software. This chapter contains the following sections:

• "Getting Started with Console Manager", page 1

• "Console Manager Graphical User Interface", page 2

• "Console Manager Server Security", page 12

• "SGIconsole Overview", page 14

• "SGIconsole Hardware Configuration", page 16

Getting Started with Console Manager
This section contains information about getting Console Manager running on your
system.

Installing Console Manager

For information on installing the Console Manager for SGIconsole, see SGIconsole 1.0
Start Here.

007–4477–001 1



1: Console Manager Features and Capabilities

For information on starting Console Manager, see "Starting the Console Manager",
page 12, and "Starting the Console Manager Graphical User Interface", page 17.

For more information on SGIconsole, see "SGIconsole Overview", page 14.

Configuring Console Manager

You can use Console Manager to configure your system to add nodes to your site.
You can also use it to add users. Console Manager automatically updates the nodes
and users files located in the var/lib/SGIconsole directory.

Note: You should not edit the /var/lib/SGIconsole/nodes and
/var/lib/SGIconsole/users files. These configuration files are generated by
SGIconsole software. Any changes to these files might be lost during upgrades to
future releases of SGIconsole.

Systems Supported

For a list of the systems supported, see the SGIconsole Hardware Connectivity Guide.
For more information on server (node) types, see "Adding a Node", page 27.

Console Manager Graphical User Interface
The Console Manager graphical user interface (GUI) enables you to set up,
administer, and monitor all the nodes in a site from a single point. A node can be an
SGI server running the IRIX operating system.

The Console Manager GUI provides these advantages:

• You can click any blue text to get more information about that concept or input
field. Online help is also provided with the Help button.

• The existance of nodes and users are shown visually.

• All inputs are checked for correct syntax before attempting to change the node
configuration information. In every task, the node configuration will not update
until you click OK.
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• Tasks take you step-by-step through configuration and management operations,
making actual changes to the sgiconsole_configuration file as you complete
a task.

Note: You should not edit the /var/lib/SGIconsole/nodes and
/var/lib/SGIconsole/users files. These configuration files are generated by
SGIconsole software. Any changes to these files might be lost during upgrades to
future releases of SGIconsole.

• The graphical tools can be run on any computer that supports a Java-enabled X
window system.

Console Manager Overview

Figure 1-1, page 4, shows the Console Manager. The menu bar shows the following
pulldown menus:

• File

• Tasks

• Help

007–4477–001 3



1: Console Manager Features and Capabilities

Figure 1-1 Console Manager Graphical User Interface

Figure 1-2, page 5, shows the File pulldown menu.
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Figure 1-2 File Pulldown Menu

The File pulldown menu allows you to perform the following actions:

• New Console Manager

• Clone this Console Manager

• Show SALog

• Close

• Exit

Note: The SAlog log shows what command are executed by the GUI and is used for
debugging Console Manager software.

Figure 1-3, page 6, shows the Tasks pulldown menu.
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Figure 1-3 Tasks Pulldown Menu

The Tasks pulldown menu allows you to perform the following actions:

• Find Tasks

• Console User Tasks

• Node Tasks

• Diagnostic Tasks

• View Log Tasks

For more information on the tasks accessed from the Tasks pulldown menu, see
"Console Manager Tasks and Functions", page 7.

Figure 1-4, page 7, shows the Help pulldown menu.

6 007–4477–001



Console Manager for SGIconsoleTM Administrator’s Guide

Figure 1-4 Help Pulldown Menu

The Help pulldown menu allows you to get:

• Console Manager description

• Overview of Console Manager tasks

• Help for each Console Manager task

Console Manager Tasks and Functions

The Console Manager provides access to the tasks that help you set up and administer
nodes at a site. The Tasks menu contains various pulldown menu tasks. For
example, the Console User Tasks menu expands to Add console user,
Modify console user, and Delete console user.

The Console Manager has the following functions:

• Find Tasks, which lets you use keywords to search for a specific task.

• Console User Tasks, which allow you to:

– Add a new Console User

– Change a Console User Password

– Delete a Console User

For a view of the Console Users Tasks pulldown menu and more information on
these tasks, see "Adding a Console User", page 20.

• Node Tasks, which allow you to:

– Add a Node

– Modify a Node Configuration

– Delete Nodes

007–4477–001 7



1: Console Manager Features and Capabilities

– Reset SGIconsole Software

– Reset/NMI/Power Up/Power Down Nodes

– Get/Steal/Spy console

– Connect to a System Controller

Note: Console users can get either system console or the system controller
console for a node at a time.

For a view of the Node Tasks pulldown menu and more information on these
tasks, see "Adding a Node", page 27.

– Diagnostic Tasks, which allow you to:

• Reset Console Backend Software

For a view of the Diagnostic Tasks pulldown menu and more information on
these tasks, see "Restarting the Console Manager Daemon", page 44.

– View LogTasks, which allow you to:

• View System Log

• View System Controller Logs

For a view of the View Log Tasks pulldown menu and more information on
these tasks, see "Viewing System Logs", page 46.

Console Manager View
The Console Manager View provides the following capabilities:

• Shows the results when a task has been completed. For example, when the Add
node task is done, you will see the new node show up in the Console Manager
View.

• Select to view nodes configured at a site or the Console Manager users.

• Find and select items in the view panel.

From the Console Manager View, you can click on a node or a user to display key
information. When an item is selected, the panel on the right shows the detailed
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information of the item with a list of applicable tasks. Clicking on a task brings up
the task window with the item selected.

Figure 1-5, page 9, shows an example of the Console Manager View window.

Figure 1-5 Console Manager View

Figure 1-6, page 10, shows an example when a node in the View window is selected.
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Figure 1-6 Detailed Console View for a Node

Figure 1-7, page 11, shows an example when a user in the View window is selected.
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Figure 1-7 Detailed Console View for a User

The Find button helps you to find node and user objects quickly. Figure 1-8, page 12,
shows an example of the Find button selected for Nodes and the dino_L2_3400
node name is entered in the Find button field to the left.
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Figure 1-8 Find Button for Nodes and Users

Starting the Console Manager
You can invoke Console Manager from the SGIconsole window or from the command
line. The command that invokes the Console Manager GUI follows:

%/usr/bin/scmgr

For more information about starting Console Manager, see "Starting the Console
Manager Graphical User Interface", page 17.

Console Manager Server Security
The Console Manager Server includes security features that ensure that only
authorized administrators can manage or monitor systems. The administrator for the
SGIconsole server is root. The SGIconsole Server password for the root user should
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be the same as the UNIX password for the root user. Only the root user can create or
delete other console users. Non-root users can peform all other Console Manager
tasks.

Note: The SGIconsole GUI does not encrypt its communication with the server. The
transfer of passwords is visible to other users of your network. Do not use the
SGIconsole GUI to administer computers over the Internet.

When you invoke the Console Manager, the window appears, as shown in Figure 1-9,
page 13.

Figure 1-9 Login in to Server Dialog Box

The Console Manager security window allows you to establish a connection to a
server to administer using the Console Manager GUI. To log in perform the following
steps:

1. In the Server field, type the name of the server running Console Manger.
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2. In the Login Name field, type your login ID.

3. In the Password field, type your password.

4. Click the Ok button.

If you cannot connect to a node running Console Manager, an error message appears.

For information about using the Console Manager GUI to add a Console Manager
user, see "Adding a Console User", page 20.

SGIconsole Overview
SGIconsole, as shown in Figure 1-10, page 15, lets you manage multiple SGI servers,
SGI partitioned systems, and large, single-system image servers.

It consists of an SGI 1100 platform, a serial multiplexer or Ethernet hub, and a
software suite, including the Console Manager/VACM package and Performance
Co-Pilot (PCP). SGIconsole provides access to common remote management tools.

You can configure SGIconsole to use a Network Information Services (NIS) password.
See the SGIconsole software package README file for instructions on how to configure
NIS on your SGIconsole machine.
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Figure 1-10 SGIconsole Web Interface

For location information and procedures for using the SGIconsole user interface to
access SGIconsole software, see the SGIconsole 1.0 Start Here.

For information on how to connect the SGIconsole to the SGI servers and graphics
systems, see the SGIconsole Hardware Connectivity Guide.
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Your SGI machine probably comes with Red Hat 6.2 and the SGIconsole 1.0 software
preinstalled. The SGIconsole Software CD Information Card document describes how to
install the software from the CD if at some time you need to reinstall it.

Note: The SGIconsole reinstallation procedure is the same as the installation
procedure described in the SGIconsole 1.0 Start Here manual, after you have removed
the SGIconsole rpms.

For information on the L1 and L2 controller commands, see Appendix B of the SGI
Origin 3000 Series Owner’s Guide.

For information on how to install the SGI Ethernet serial port server (also know as
the EL serial port server and as EtherLite, see the EL Serial Port Server Installation
Guide and the EL Serial Port Server Installation Guide Errata.

For information on Performance Co-Pilot (PCP) see the following manuals:

• Performance Co-Pilot ReadMe First

• Performance Co-Pilot IRIX Base Software Administrator’s Guide

• Performance Co-Pilot Programmer’s Guide

• Performance Co-Pilot User’s and Administrator’s Guide

SGIconsole Hardware Configuration
The SGIconsole system is the SGI 1100 server rack-mountable hardware running
several pieces of SGI software to manage and monitor the SGI servers and graphic
systems. For detailed information about the SGIconsole hardware configuration, see
the SGIconsole Hardware Connectivity Guide.
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Chapter 2

Configuring Console Manager

This chapter describes various tasks you must perform to install and configure
Console Manager software. It contains the following sections:

• "Installing Console Manager", page 17

• "Starting the Console Manager Graphical User Interface", page 17

• "Quitting the Console Manager Graphical User Interface", page 18

• "Adding a Console User", page 20

• "Deleting a Console User", page 22

• "Changing A Console User Password", page 24

Installing Console Manager
For information on how to install the Console Manager and the rest of SGIconsole
software, see SGIconsole 1.0 Start Here.

Starting the Console Manager Graphical User Interface

Procedure 2-1 Starting the Console Manager Graphical User Interface

To start the Console Manager GUI, follow these steps:

1. Make sure the SGIconsole machine, in which Console Manager resides, the
servers and graphics systems supported by SGIconsole, and the Silicon Graphics
Ethernet serial port server are cabled as described in the SGIconsole Hardware
Connectivity Guide.

2. Make sure all systems are powered on.

3. If you are running as root, to set your DISPLAY variable enter the following
command:

export DISPLAY=hostname.engr.sgi.com:0.0

007–4477–001 17



2: Configuring Console Manager

If you are not running as root, to set your DISPLAY variable enter the following
command:

setenv DISPLAY hostname.engr.sgi.com:0.0

4. To start the Console Manager graphical user interface (GUI), you can use the
SGIconsole web page interface or enter the following command in any window:

%/usr/bin/scmgr

The Console Manager GUI appears, as shown in Figure 2-1, page 18.

Figure 2-1 Console Manager Graphical User Interface Main Window

Quitting the Console Manager Graphical User Interface

Procedure 2-2 Quitting the Console Manager Graphical User Interface

To quit the Console Manager GUI, perform these steps:
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1. From the File pulldown menu, choose Exit, as shown in Figure 2-2, page 19.

Figure 2-2 Quitting Console Manager

A confirmation message dialog box appears, as shown in Figure 2-3, page 19.

Figure 2-3 Software Control Confirmation Message Dialog Box
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2: Configuring Console Manager

2. Click the Yes button.

Adding a Console User

Procedure 2-3 Adding a Console User

This task allows you to create a console user. This task is only executable by the root
console user. You must specify a user name.

If you are adding a new user that does not exist as a system user or NIS user, a
password is required.

If you are adding a user that exists as a system user or NIS user, a password is
optional.

Both the name and the password must not be longer than 8 characters.

To add a Console user, follow these steps:

1. From the Tasks menu, choose the following, as shown in Figure 2-4, page 21.
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Console Users Tasks
> Add a new Console User

Figure 2-4 Add a new Console User Task

2. The Add a new Console User dialog box appears, as shown in Figure 2-5, page 22.
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Figure 2-5 Add a new Console User

3. Enter the new user’s login and password.

4. Click the OK button.

You will get an error message if the task fails.

The user icon entry appears on the View panel.

Deleting a Console User

Procedure 2-4 Deleting a Console User

This task allows you to delete a user. The task is executable only by the root console
user and you must specify the root password. This task only removes this user from
the Console user list. If you select the Also Delete User Account, you also delete the
user account.

To delete a Console Manager user, follow these steps:
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1. From the Tasks menu, choose the following:

Console Users Tasks
> Delete a Console User

2. The Delete a Console User dialog box appears, as shown in Figure 2-6, page 23.

Figure 2-6 Delete a Console User Dialog Box

3. Enter the user name.

4. Click the Also Delete User Account button is you also want to remove the user
account

5. Enter the root password.

6. Click the OK button.

You will get an error message if the task fails.

The user icon entry is removed from the View panel.
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Changing A Console User Password

Procedure 2-5 Changing a Console User Password

This task allows you to change a console user password. It can be executed by any
console user.

To change a console user password, follow these steps:

1. From the Tasks menu, choose the following:

Console Users Tasks
> Change a Console User Password

2. The Change a Console User Password dialog box appears, as shown in Figure
2-7, page 24.

Figure 2-7 Change a Console User Password Dialog Box

3. Enter the your user name, your current password , and your new password.
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4. Click the OK button.

An error message appears if the task fails.

007–4477–001 25





Chapter 3

Configuring Sites

This chapter describes various tasks you must perform to complete the initial
configuration your site. It contains the following sections:

• "Adding a Node", page 27

• "Deleting a Node", page 32

• "Modifying a Node Configuration", page 34

Adding a Node

Procedure 3-1 Adding a Node

This task lets you define a new node. After defining the node, you can use Console
Manager to perform functions such as reset, power up, power down, get console, and
spy console by running tasks from the Node Tasks pulldown menu.

The following tables shows which fields are required for various node types (see step
2 for more information on node types):

Node Type Fields Required

All Nodes Node name, user name, hostname for this node

L2 Partition number, L2 address

L1 System Controller TTY device name

MSC System controller TTY device name, console TTY device
name, system controller password (optional), Serial
speed.

MMSC System controller TTY device name, system controller
password (optional).

To add a node to Console Manager, follow these steps:

1. From the Tasks pulldown menu, choose the following, as shown in Figure 3-2,
page 29.
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Node Tasks
> Add a Node

Figure 3-1 Node Tasks Pulldown Menu

The Add a Node Dialog dialog box appears, as shown in Figure 3-2, page 29.
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Figure 3-2 Add a Node Dialog Dialog Box

2. In the Add a Node Dialog Box fields, add the following information:

• Node Name: The name you want to assign to this node, such as lightning1.

• Management Port Type: From the Management Port Type pulldown menu
(see Figure 3-3, page 30) choose one of the following node types:

Note: When you select a type, the non–applicable fields are deactivated.
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Note: Console Manager does not support any connection types not provided
by SGI. Only the following nodes can be added: SGI Origin 200, SGI Origin
2000, Silicon Graphics Onyx2, SGI Origin 300, SGI Origin 3000, SGI Origin 300
with a NumaLink module and a Silicon Graphics Onyx 3000. Any node that
does not support MMSC, MSC, L1 or L2 protocols will not work.

– 02000 Single Module (MSC) SGI Origin 2000 system with a single module
System Controller (MSC)

– 02000 Rackmount Module (MMSC) SGI Origin 2000 rackmount system
with a multimodule System Controller (MMSC)

– 0200 (MSC) SGI Origin 200 system with MSC

– 03000 (L2) SGI Origin 3000 system with rack-level L2 system controllers

– 0300 (L1) SGI Origin 300 system with an L1 system controller or an SGI
Origin 3200C system with an L1 system controller

Figure 3-3 Management Port Type Pulldown Menu
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• Console TTY Device Name: The device name of the port that is connected to
the console port on the node, such as /dev/ttyN011, which would be port
12 on the EL-16 unit. This field is not applicable for L2 management port type.

• Console TTY Serial Speed: If you selected the 02000 Single Module (MSC)
or 0200 (MSC) Management Port type from the pulldown menu, select one of
the following baud rates: 300, 1200, 2400, 4800, 9600, 19200, 38400, or 57600, as
shown in Figure 3-4, page 31.

Figure 3-4 Console TTY Serial Speed: Pulldown Menu

For MMSC and L2 Management Port types, this field is disabled.

• System Controller TTY Device Name: Name of the terminal port (TTY) on
the EL-16 unit to which the system controller is connected, such as
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/dev/ttyN012. The other end of the cable connects to this node’s system
controller port, so the node can be controlled remotely by the other node.

• System Controller Password: The password for the system controller port, not
the node’s root password or PROM password. On some machines, the system
administrator may not have set this password. If you wish to set or change the
system controller port password, consult the hardware manual for your node.

• Partition Number: Uniquely defines a partition in a partitioned SGI Origin
3000 system. Valid partition numbers range from 1 to 256. This is a required
parameter for SGI Origin 3000 systems with an L2 controller. If your system is
not partitioned, enter zero in this field.

• L2 Address: L2 system controller Internet Protocol (IP) address of the private
network or hostname. You can either enter a resolvable hostname, a fully
qualified hostname, such as name.sgi.com. or an IP address, such as 192.1.2.3.
This is a required parameter for SGI Origin 3000 systems with an L2 controller.

• User Name for Viewing Log: Example: Root user. This user name is used to
log into the node to obtain the logs to display.

• Host Name: Hostname of the node you are defining, such as
mynode.company.com.

The host name is for rsh access to the node managed by the Console Manager.
This host name is not the same as the SGIconsole host name but may be the same
as the node name assigned in the Node Name field. You need a .rhosts entry
for the SGI 1100 system on the target system.

3. Click the OK button.

An error message appears if the task fails.

An icon entry appears on the View panel.

Deleting a Node

Procedure 3-2 Deleting a Node

This tasks allows you delete a node or group of nodes.

To remove a node from Console Manager, follow these steps:
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1. From the Tasks pulldown menu, choose the following, as shown in Figure 3-2,
page 29.

Node Tasks
> Delete Nodes

The Delete Nodes dialog box appears, as shown in Figure 3-5, page 33.

Figure 3-5 Delete Nodes Dialog Box

2. Select a node that you want to delete from the list on the left and click the right
arrow button to move the node to the right. The list of nodes on the right are the
nodes that will be deleted when you click the OK button. You can select a block
nodes at a time by the holding down the Shift button on your keyboard and
clicking on another node.

3. Click the OK button

An error message appears if the task fails.

The icon entry is removed from the View panel.
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Modifying a Node Configuration

Procedure 3-3 Modifying a Node Configuration

This task lets you modify a node. You select the node to modify by clicking on the
down arrow button on the Node Name tab.

To modify a Node configuration, follow these steps:

1. From the Tasks pulldown menu, choose the following:

Node Tasks
> Modify Node configuration

The Modify a Node Configuration dialog box appears, as shown in Figure 3-6,
page 35.
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Figure 3-6 Modify a Node Configuration Dialog Box

2. In the Modify a Node Configuration dialog box fields, modify the fields as
required. For an explanation of each field, see "Adding a Node", page 27.

3. Click the OK button

If you attempt to modify a node in a way not allowed by the Console Manager,
an error message appears.
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Chapter 4

Administering Your Site

This chapter explains how to use Console Manager to administer the nodes that it
controls.

The main Console Manager GUI, described in Chapter 3 of this manual, allows you to
power down, power up, reset a node, generate a non-maskable interrupt (NMI), and
change the properties of a node, view system logs for a specific node in a site, or
connect to, spy, or steal the system console for a specific node. This chapter describes
how you can use the Console Manager GUI to perform these administrative actions.

This chapter contains the following sections:

• "Powering Down, Powering Up, Resetting, or Interrupting a Node", page 39

• "Getting, Stealing, or Spying a System Console", page 37

• "Restarting the Console Manager Daemon", page 44

• "Viewing System Logs", page 46

Getting, Stealing, or Spying a System Console

Procedure 4-1 Connecting to a System Console

This task creates a console window for the node as follows:

• The Get option creates a read-write console window if there is no other read-write
console in use for that node.

• The Steal option creates a read-write console window and converts any other
read-write console in use to a read-only window.

Note: If there is a System Controller Console window opened, the Steal option
will close it and open a new read-write console window.

• The Spy option creates a read-only console window.

1. From the Tasks pulldown menu, choose the following, as shown in Figure 3-1,
page 28.
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Node Tasks
> Get/Steal/Spy Console

The Get/Steal/Spy Console dialog box appears, as shown in Figure 4-1, page 38.

Figure 4-1 Get/Steal/Spy Console Dialog Box

2. In the Display field, type the name of you system where the console window
should be displayed.

3. In the Node field, using the pull-down tab select the name of the server for which
you want to get, steal, or spy the system console.

4. In the Mode field, select the Get, Spy, or Steal button.

5. Click the OK button.
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Powering Down, Powering Up, Resetting, or Interrupting a Node

Procedure 4-2 Powering Down, Powering Up, Resetting, or Interrupting a Node

This task allows you to power down, power up, reset a node, or send a nonmaskable
interrupt to a node.

To power down, power up, reset, or send a nonmaskable interrupt (NMI) to a node,
follow these steps:

1. From the Tasks pulldown menu, choose the following:

Node Tasks
> Reset/ NMI/ Power Up/ Power Down

The Reset/NMI/Power Up/Power Down dialog box appears, as shown in Figure
4-2, page 39.

Figure 4-2 Reset/NMI/Power Up/Power Down Dialog Box
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2. From the Server field pulldown tab, select the node to which you want to
perform the operation, as shown in Figure 4-3, page 40.

Figure 4-3 Reset/NMI/Power Up/Power Down Server Pulldown Menu

3. Click the button to the left of the operation you wish to perform.

4. Click the OK button.

Connecting to the System Controller for a Node

Procedure 4-3 Connecting to the System Controller for a Node

This task lets you open a connection to the system controller of a node as follows:

• The Get option will succeed only if there are no other System Controllers or node
Console windows open.

• The Steal option will forcefully close all other Console windows on the node and
open a new System Controller Console window.

1. From the Tasks pulldown menu, choose the following, as shown in Figure 4-4,
page 41.
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Node Tasks
> Connect to a System Controller

Figure 4-4 Connect to a System Controller

The Connect to a System Controller dialog box appears, as shown in Figure 4-5,
page 42.
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Figure 4-5 Connect to a System Controller Dialog Box

2. In the Display field, type in your display hostname as follows:

hostname.mycompany.com:0

3. From the Node field pulldown tab, choose the name of the node for which you
want the system controller, as shown in Figure 4-6, page 43.
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Figure 4-6 Connect to a System Controller Node Type Pulldown Menu

4. In the Mode field click the Get or Steal button.

5. Click the OK button.

A System Controller Console appears, as shown in Figure 4-7, page 44.
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Figure 4-7 System Controller Console

Restarting the Console Manager Daemon

Procedure 4-4 Restarting the Console Manager Daemon

This tasks allows you to restart the Console Manager (nexxus) daemon. Running
this task will cause all opened console windows to disappear for all users.

1. From the Tasks pulldown menu, choose the following, as shown in Figure 4-8,
page 45.
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Diagnostics Tasks
> Reset Console Backend Software

Figure 4-8 Resetting the Console Manager Daemon

The Reset SGIconsole Software dialog box appears, as shown in Figure 4-9, page
46.
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Figure 4-9 Reset SGIconsole Software Dialog Box

2. Click the OK button.

Viewing System Logs

Procedure 4-5 Viewing System Logs

This task allows you to view system logs (syslog) of the servers and system
controller logs of the servers.

Note: Console users can get only the system console or the system controller console
for any node at one time.

Note: For SGI Origin 2000 rackmount servers (servers that use the multimodule
System Controller (MMSC)), the system controller logs from the module System
Controllers (MSCs) in rack 1 (both upper and lower bays) are displayed.

To get the system log or system controller logs for a server, follow these steps:

1. From the Tasks pulldown menu, choose View Log Tasks, as shown in Figure
4-10, page 47.
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Figure 4-10 Getting the System Log

2. Choose View System Log or View System Controller Logs.

The View System Log Dialog Box (or View System Controller Logs Dialog Box)
appears, as shown in Figure 4-11, page 48.
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Figure 4-11 View System Log Dialog Box

3. In the Display field, type in your display hostname as follows:

hostname.mycompany.com:0

4. From the Server field pulldown tab, choose the name of the node for which you
want the system log, as shown in Figure 4-12, page 48.

Figure 4-12 View System Log Pulldown Menu

The system log window appears, as shown in Figure 4-13, page 49.
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Figure 4-13 System Log

Note: If the log screen does not appear, make sure that you enter your complete
display name as shown in Procedure 4-5, page 46.
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Appendix A

SGIconsole Log Files and Console Manager
Execution Flow

This chapter describes the following topics:

• "SGIconsole Log Files", page 51

• "Console Manager Execution Flow", page 51

SGIconsole Log Files
The following log files provide useful information on SGIconsole operations:

SGIconsole Log Description

/var/log/vacm.log Resides on the SGIconsole system and contains a log of
VACM activity.

/var/adm/SYSLOG Resides on every IRIX server and contains a log of
messages written to the system console.

/var/lib/sysadm/salog The ConsoleManager GUI log which contains all
backend command and parameters executed by the
console manager GUI.

/tmp/els00.log The log for the first EL-16 device installed and contains
the following when the EL-16 device is configured
successfully:

[root@linux1 /tmp]# cat els00.log

09/19/01 09:03:16: EtherLite daemon running

09/19/01 09:03:16: Vendor ID: DigiIntl, Firmware Version: V7.6
Model Name: EL-16, IP Address: 192.12.1.20

09/19/01 09:03:16: Unit Online

Console Manager Execution Flow
Each Console Manager task has the following flow of execution when a GUI task is
executed, such as connecting to a node or getting a console port:
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GUI task —> privcmd CLI —> VACM (nexxus) —> VACM plugins —> EL-16 driver
(if present)

Key:

• privcmd = privileged command

• CLI = command line interface

• VACM = cluster manager software

• nexxus = Console Manager backend software (Console Manager daemon)

• VACM plugins = SGI software plugins to support various SGI servers.
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System logs, 46
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